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sSoftware Starter Guide

To Download Images to a Computer for
Windows

for
Macintosh

Install the Software P.5 P.39

Connect the Camera to a Computer P.7 P.40

Start the Software and Download Images P.15 P.45

Start ZoomBrowser EX (Windows) or PowerShot Browser (Macintosh 
computers) and load images onto the computer.

This is the software guide for both PowerShot S10 and PowerShot S20 digital cameras.

This guide explains the installation method and features of
the software for loading and processing images on a computer that have
been shot with a Canon PowerShot S10 or PowerShot S20 digital camera.

Read the agreement in this guide before using the software on
the supplied CD-ROM. By using the software,

you agree to be bound by the terms of the agreement.

There are precautions that you should take before installing the USB
driver software. Ensure that you read this guide before installing it.

Software Starter Guide



READ CAREFULLY BEFORE USING!
CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN
THIS BOX.  BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS
AGREEMENT.

This is a license agreement (the “Agreement”) between you and Canon Inc. (“Canon”).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE “SOFTWARE”) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and
conditions of this Agreement.

1.  LICENSE:  Canon grants you the non-exclusive right to use the SOFTWARE only on a
single computer.  You may physically transfer the SOFTWARE from one computer to
another provided that the SOFTWARE is used on only one computer at a time.  You
shall not install or use the SOFTWARE on a network, multiple CPU, multiple site
arrangement, or any other hardware configuration where the SOFTWARE is accessible
to more than one CPU or to more than one user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2.  BACK-UP COPY:  You may make one copy of the SOFTWARE solely for back-up
purposes, or copy the SOFTWARE onto the permanent storage device (e.g. a hard disk)
of your computer and retain the original for back-up purposes.  Any other copying of
the SOFTWARE is a violation of this Agreement.  You must reproduce and include the
copyright notice on the back-up copy.

3.  SUPPORT AND UPDATES:  Canon is not responsible for providing maintenance or
support  for use of the SOFTWARE.  No updates, fixes or support will be made available
for the SOFTWARE.

4.  LIMITED WARRANTY AND LIMITATION OF LIABILITY:  It is your responsibility to choose,
maintain and match the hardware and software components of your computer system.
Thus Canon does not guarantee uninterrupted service or correction of errors or that
the functions or performance of the SOFTWARE will meet your requirements.  THE
SOFTWARE IS LICENSED ON AN “AS IS” BASIS AND WITHOUT WARRANTY OF ANY
KIND. The CD-ROM storing the SOFTWARE is warranted only against defective material
under normal use for a period of ninety (90) days after purchase from an authorized
Canon dealer as evidenced by your sales receipt. Your sole remedy for a defective CD-
ROM shall be replacement of the same without charge when returned by you at your
expense to your point of purchase and proven to be defective upon inspection.  The
Replacement CD-ROM will be warranted for the remainder of the original ninety (90)
day warranty period of the defective CD-ROM.  The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the
SOFTWARE and shall not extend to anyone other than the original user of the
SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.
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NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5.  TERM:  This Agreement is effective upon your using the SOFTWARE and remains in
effect until expiration of all copyright interests in the SOFTWARE unless earlier
terminated.  You may terminate this Agreement by destroying the SOFTWARE.  This
Agreement will also terminate without notice to you if you fail to comply with any of
the terms of this Agreement and you must then promptly return the SOFTWARE.  In
addition, Canon may enforce its other legal rights.

6.  U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:  The SOFTWARE is provided with
restricted rights.  Use, duplication or disclosure is subject to restrictions as set forth in
either subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software
clause at DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial
Computer Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7.  SEVERABILITY:  In the event that any provision of this Agreement is declared or found
to be illegal by any court or tribunal of competent jurisdiction, such provision shall be
null and void with respect to the jurisdiction of that court or tribunal and all the
remaining provisions of this Agreement shall remain in full force and effect.

8.  CONTROLLING LAW:  The terms of this Agreement as it relates to purchases of the
Software in the United States of America shall be governed and construed in all
respects in accordance with the laws and regulations of the State of New York, without
reference to choice of law principles.  The terms of this Agreement as it relates to
purchases of the Software in Canada shall be governed by the laws of the province of
Ontario.

9.  OWNERSHIP:  All rights, including but not limited to copyrights and trade secret rights,
to the SOFTWARE belong to Canon, its affiliated corporations and third party licensors.
Your use of the SOFTWARE is subject to the United States, Canada and other applicable
copyright and trademark laws and nothing in this Agreement constitutes a waiver of
the rights of Canon, its affiliated corporations and third party licensors under such laws.
Nothing contained in Paragraph 1 shall be construed to give Canon any ownership
rights in any images, graphics or textual material that you save in connection with the
Software.

10.  ACKNOWLEDGEMENT:  BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS.  YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS OR
PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF.  NO AMENDMENT
TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED
OFFICER OF CANON.
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Disclaimer
• While every effort has been made to ensure that the information contained in this guide is

accurate and complete, no liability can be accepted for any errors or omissions. Canon Inc.
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior
written permission of Canon Inc.

• Canon Inc. makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, the CompactFlash™ cards
(CF cards), personal computers, peripheral devices, or use of non-Canon CF cards.

Trademark Acknowledgments
• Canon and PowerShot are trademarks of Canon Inc.
• Adobe, Adobe PhotoDeluxe and Photoshop are trademarks of Adobe Systems Incorporated.
• CompactFlash is a trademark of SanDisk Corporation.
• IBM is a registered trademark of International Business Machines Corporation.
• iBook and iMac are trademarks of Apple Computer, Inc.
• Macintosh, PowerBook, Power Macintosh and QuickTime are trademarks of Apple Computer

Inc., registered in the United States and other countries.
• Microsoft, Windows and Windows NT are either registered trademarks or trademarks of

Microsoft Corporation in the United States and/or other countries.
• Other names and products not mentioned above may be registered trademarks or trademarks of

their respective companies.

Copyright © 2000 Canon Inc. All rights reserved.

This guide explains the software used with both the PowerShot S10 and PowerShot S20.
All instructions apply to both models unless otherwise noted. The screen examples in this
guide were taken with a PowerShot S10 connected unless otherwise noted.
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Introducing the Software

This section introduces the powerful software programs provided on the supplied CD-ROM
for the Windows platform.

PowerShot Solution Disk

ZoomBrowser EX

To load PowerShot S10/S20 images, start ZoomBrowser EX.

PowerShot S10/S20 Connection Functions
(Also effective for CF card readers or PC card readers)

• Displays the camera images.
• Downloads camera images to the computer.
• Saves computer images to a CF card in the camera.
• Edits slide shows for replay by the camera.
• Automatically starts and displays camera images when the camera is connected to a

USB port.

Image File Management Functions
• Displays, moves, copies or deletes images stored on computer disks.
• Displays all the files in a specified folder at once and zooms them in and out to

facilitate visual searches.
• Displays files in chronological order in a window that looks like a time tunnel.

Image Printing Functions
• Prints multiple images on the same page using the PhotoRecord printing utility.
• Performs auto layouts.
• Allows you to effortlessly place frames or backgrounds around your images for artistic

effect.
• Lets you create your own exclusive albums.

Supports PhotoStitch Panoramas
• Allows you to select camera images or images registered with ZoomBrowser EX and

start PhotoStitch to merge a series of images into a panorama in a few simple steps.

Supports the Adobe PhotoDeluxe Photo Retouching Program
• Starts the Adobe PhotoDeluxe photo retouching program so you can edit and apply

special effects to your images.
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PhotoStitch
• Automatically arranges images shot in Stitch Assist mode into the correct order and

effortlessly merges them.
• Merges any number of images horizontally or vertically, or in a matrix format.
• Makes images with straight lines appear natural not crooked when merged. (Select the

Wide display format)
• A 360 degrees scene shot in several frames can be merged into a 360 degrees image

and saved in the QuickTime VR format, making it appear as if you were standing in the
middle of the image looking about in all directions.

TWAIN Drivers
PowerShot USB TWAIN Driver
PowerShot RS-232C TWAIN Driver

These are the driver utility programs that work within TWAIN-compliant application
programs, such as Adobe PhotoDeluxe and Photoshop, to load camera images
directly into the application program. (The USB TWAIN Driver is for use with a USB
interface. The RS-232C TWAIN Driver is for use with a serial port interface.)
Neither TWAIN Driver can be used as a stand-alone software program.

 Adobe PhotoDeluxe (separate CD-ROM)

• Allows you to edit images and effortlessly create greeting cards, birthday cards and
calendars.

If the accompanying CD-ROM with the PowerShot S10 is a PowerShot S10 Solution
Disk, this CD-ROM is for exclusive use with the PowerShot S10. It cannot be used
with a PowerShot S20.
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System Requirements

The following system requirements must be met to install and operate the software.

• A CD-ROM drive is required to install the software.
• QuickTime 3.0 or higher is required to save images in the QuickTime VR format that

have been merged in PhotoStitch.

•Computer Model
IBM PC/AT compatible

•OS
Windows 95, Windows 98 (including Second Edition)
or Windows NT 4.0 (Service Pack 3 or higher required)

•CPU
Pentium 75 MHz or better

•RAM
32 MB or more (Windows 95/98)
64 MB or more (Windows NT 4.0)

•Interface
USB (Limited to pre-installed Windows 98 systems)
RS-232C (Serial/COM port)

•Free Hard Disk Space
PowerShot Utilities
   ZoomBrowser EX: 120 MB or more
          (Including the PhotoRecord printing utility)
    PhotoStitch: 40 MB or more
PowerShot USB TWAIN Driver: 15 MB or more
PowerShot RS-232C TWAIN Driver: 15 MB or more
Adobe PhotoDeluxe Home Edition: 140 MB or more

•Display
800 x 600 pixels, 256 colors minimum
1,024 x 768 pixels, 16 bit color or more recommended
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Installing the Software

Installing from the PowerShot Solution Disk

1. Close any application programs that are running.

2. Place the supplied Solution Disk in the CD-ROM drive.
The installer panel will automatically display.

• If the installer panel does not automatically display, use the following procedures
to start it.
1. Double-click the [My Computer] icon on the desktop, and double-click the CD-ROM

icon.
2. Double-click the [Setup] icon.

3. Click [Software Installation].

4. Select the install location and click the [Next] button.
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5. Select the software that you wish to install.
• Select [Standard Setup] for a typical installation.
• Select [Custom Setup] if you wish to install only the minimum required programs.

Software Installed with the Standard Setup Option
PhotoStitch
PowerShot RS-232C TWAIN Driver
ZoomBrowser EX

PhotoRecord (prints images registered with ZoomBrowser EX)
OpenPage Print Component (software driver used by PhotoRecord)

• Follow the on-screen instructions to proceed with the installation.

6. Click the [Finish] button when the installation is complete and the
installer panel appears again.

Installing Adobe PhotoDeluxe Home Edition
For installation instructions, place the Adobe PhotoDeluxe CD-ROM in the drive and
click [ReadMe & Guide] and [Install Guide] in the window that displays.

The serial number shown during installation will be required for the user
registration process.

If You Will Be Connecting via a USB Port
You must install a separate USB driver and the PowerShot USB TWAIN Driver.
Please see page 10 for installation instructions.
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Connecting the Camera to a Computer

There are three interfaces that can be used to connect the camera to a computer. Once a
connection is established using one of the three interfaces, you can start the software
and begin to load the camera images. (➔ p. 15 or 28)

Connecting to a USB Port (➔ p. 8)
If your computer is equipped with a USB port such as that shown below, you can
connect the camera to it with the supplied USB cable.
• The USB interface transfers data more rapidly than the serial interface and can start

the image loading software automatically.

• The camera will not operate correctly with a USB port controlled by the Windows 95
or Windows NT 4.0 operating system.

Connecting to a Serial Port (COM Port) (➔ p. 13)
If your computer is equipped with a serial port such as that shown below, you can
connect the camera to it with the supplied serial cable.

Connecting via a CF Card Reader or PC Card Slot (➔ p. 14)
If your computer is equipped with a CF card reader or PC card slot, you can place the
camera’s CF card into either device to establish a direct connection.

Computer’s USB PortConnectors on Ends of USB Cable

To the Camera To the Computer

USB Ports are
identified with
this mark.

Computer’s Serial PortConnectors on Ends of Serial Cable

To the Camera To the Computer

Serial Ports are
identified with
this mark.
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Connecting to a USB Port

Requirements for the USB Interface
• The USB interface can only be used to connect the camera to computers

purchased with Windows 98 preinstalled (clean installation). The USB ports on
computers running versions of Windows 98 upgraded from Windows 3.1 or
Windows 95 may not operate correctly.

• Connect the USB cable directly to one of the computer’s main USB ports. The
interface may not function correctly if the camera is connected via a USB HUB.

• The interface may not function correctly while other USB devices, excluding USB
mice and keyboards, are connected. If this problem arises, detach the camera
and the other devices, and reconnect the camera only.

• Do not connect more than one camera to the USB ports of the same computer
at the same time. The cameras may not operate correctly.

Important
Please do not place your computer into standby mode while this camera is
connected to its USB port. If the computer is placed into standby mode while
the camera is connected to the USB port, do NOT disconnect the USB cable
from the camera or computer. Try to revive the computer. If the USB cable is
detached while the computer is in standby mode, some models of computer
may not return to active mode correctly. For instructions regarding the
standby mode, please consult the manual accompanying your computer and
operating software.
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PUSH Button

1. Attach the supplied USB cable to a USB port directly on the computer
and to the DIGITAL terminal of the PowerShot S10/S20 as shown below.
• There is no need to turn the camera or computer power off when attaching or

detaching the USB cables.
• Please consult your computer’s manual for the location of the USB ports.
• The camera can be connected to any USB port on computers that feature more

than one.

2. Install the USB driver and the PowerShot USB TWAIN Driver (First connec-
tion only). (➔ pp. 10-12)

USB Port

USB Cable
DIGITAL Terminal
1. Open the DIGITAL

terminal cover by slipping
a fingernail under the top
edge and pulling down.

2. Insert the cable so that the  marks on
the cable and camera align.

Always press the [PUSH] button on the connector to
detach the cable from the camera’s DIGITAL terminal.

USB Cable

Precaution for Unplugging Cables from the
DIGITAL Terminal
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• Your computer may prompt you to insert the CD-ROM containing your Windows system
software during the installation. Have the Windows disk handy in case it is required.

1. Attach the PowerShot S10/S20 to the computer's USB port and turn the
mode dial to the  position (➔ p. 8).
The [Add New Hardware Wizard] will appear after a moment.

2. Read the dialog and click the [Next] button.

The dialog will change to the search selection dialog.

What to Do if the Installation Does Not Proceed Properly
Read the Troubleshooting the Driver Software Installation section on page 30 if the
installation cancels itself during the procedure, if the installation does not proceed as
described in these procedures, or if you think that the drivers are not properly installed.

Installing the Driver Software
(Preinstalled Windows 98 Systems)  First USB Connection Only

Note Regarding Installation
• The driver installation process will install two programs: USB Driver and

PowerShot USB TWAIN Driver.
• Do not cancel the installation partway through. Allow the procedure to finish completely

before exiting. The camera may not operate correctly if the installation is incomplete.
• The driver installation is only required the first time the camera is connected via the

USB interface. It is not required from the second time onward.



11

W
in

d
o
w

s

3. Select the [Search for the best driver for your device (Recommended)]
option and click the [Next] button.

The dialog will change to one that allows you to specify the search location.

4. Select the [CD-ROM drive] option.

5. Place the PowerShot Solution Disk in the CD-ROM drive and click the
[Next] button.

6. Read the dialog and click the [Next] button.
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The file copying process will initiate.

When all the necessary files have been copied, the dialog will state that the
installation is complete.
• Your computer may prompt you to place the CD-ROM containing the Windows

system software into the CD-ROM drive. See the box below.

7. Read the dialog and click the [Finish] button.

The [PowerShot S10 Event] or [PowerShot S20 Event] dialog will display to allow
you to select application programs. (➔ p. 15 Step 4, p. 28 Step 3)
• If a dialog prompts you to restart your computer, remove the Disk from the

CD-ROM drive and restart the computer as prompted.

What to Do If You Are Prompted for the Windows System
Disk during the Driver File Copying Process

If prompted for the Windows system disk, replace the PowerShot Solution Disk with it and
perform the requested procedures. If a dialog states that the [usbscan.sys] file cannot be
found, click the [Browse] button and specify the location as the [WIN98] folder on the
Windows system CD-ROM. Be sure to specify [WIN98] on the Windows system CD-ROM,
not the location for the [usbscan.sys] file that appears in the dialog.

Do not click the [Cancel] button
while copying is in progress.
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Connecting to a Serial Port (COM Port)

1. Shut down the computer and turn the camera’s mode dial to the Off
position.

2. Attach the supplied serial cable to a serial port on the computer and to
the camera’s DIGITAL terminal as shown below.
• Please consult your computer’s manual for the location of the serial port.

3. Turn on the computer and start Windows.

Precaution for Unplugging Cables from the
DIGITAL Terminal

Serial Cable

Serial Port (COM Port)

DIGITAL Terminal
1. Open the DIGITAL terminal

cover by slipping a
fingernail under the top
edge and pulling down.

2. Insert the cable so that the  marks on
the cable and camera align.

Always press the [PUSH] button on the connector to
detach the cable from the camera’s DIGITAL terminal.

PUSH Button

Serial Cable
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Connecting via a CF Card Reader or PC Card Slot

To load images directly from a CF card to a computer, eject the card from the camera,
place it in a separately sold PC card adapter (PCMCIA card adapter) and insert the
assembly into the PC card slot as shown below.
The adapter is not required if your computer is equipped with a CF card reader. Place the
CF card directly into the reader.

1. Place the CF card in the PC card adapter.

2. Insert the assembly into the computer’s PC card slot or a PC card reader
attached to the computer.
The requirements for the power being on or off when the PC card adapter is
inserted differ according to the product. Please consult the manuals accompanying
your equipment.

Place CF Card in Adapter

Insert into Slot
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Starting ZoomBrowser EX
1. Open a connection between the camera and computer.

• Connecting to a USB Port (➔ p. 8)
• Connecting to a Serial Port (➔ p. 13)
• Connecting via a CF Card Reader or PC Card Slot (➔ p. 14)

2. Turn the camera’s mode dial to the  position.

3. Start ZoomBrowser EX.
• Double-click the [Canon PowerShot] icon on the desktop.
• If the [Canon PowerShot] icon does not appear on the

desktop, click the Windows [Start] button and select
[Programs], [Canon PowerShot Utilities], [ZoomBrowser
EX] and [ZoomBrowser EX].

Quick Tips will automatically display. Read these tips to
quickly understand operating procedures.

4. Use one of the three interfaces to display the camera window.
USB Interface
The [PowerShot S10 Event] or [PowerShot
S20 Event] dialog will appear so that you
can select an application to start when you
connect the camera to a USB port. Select
ZoomBrowser EX and click the [OK] button.
ZoomBrowser EX will start and thumbnail
images will display in the camera window.
(➔ p. 17)

From Loading to Printing

This section provides a simple explanation of the procedures for using ZoomBrowser EX to
load and print images. Please refer to the ZoomBrowser EX Help file for more details.

Auto Save and Batteries
When the camera is connected to a computer and powered by a 2CR5 lithium
battery or Battery Pack NB-5H, a message will ask if you wish to remain connected
after approximately five minutes without a camera control being accessed. If you
select [No], the camera will shut down after approximately one minute (PC icon
disappears from the display panel). You can restore the connection by pressing
the shutter button (PC icon displays in the display panel).

Canon PowerShot Icon
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Settings for Applications that Start Automatically
• Follow the procedures below to start ZoomBrowser EX without first displaying the

[PowerShot S10 Event] or [PowerShot S20 Event] dialog.
1. Open the [My Computer] window while the camera is connected to the

computer via the USB interface.
2. Open the [Control Panel] and select [Scanners and Cameras] and either

[PowerShot S10] or [PowerShot S20].
3. Click the [Properties] button and display the [Events] tab.
4. A list of applications registered for automatic starting will display. Remove the

checks beside every program except for ZoomBrowser EX. Click the [OK] button.
ZoomBrowser EX will now start automatically the next time you connect the camera. If the
[Disable device events] option has a check mark, the automatic start will be turned off.

Serial Interface

Click the [IMPORT IMAGES] button and select [From Camera]. Thumbnail images
will display in the camera window.  (➔ p. 17)

Having Trouble Connecting to the Computer?
If the settings for the COM port are not correct, the [Communication Settings]
dialog will display. (It will not display if you are connecting via a USB port.)

• Set the port type, port name and baud rate settings and click the [OK] button.
• Select [RS-232C] for the port type. For the port name, select the port to

which the interface cable is connected. If you are uncertain about the port
to which it is connected, click the [Detect] button.

• There is usually no need to change the baud rate setting from 115.2 K,
but if you are having trouble with the connection, try a slower baud rate.
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PC Card Reader or PC Card Slot Interface

Click the [IMPORT IMAGES] button and select [From Dcim]. Thumbnail images will
display in the camera window.

ZoomBrowser EX Camera Window
The camera window will open when a connection to a camera or CF card is initiated.
Thumbnail (small) images will display.

Thumbnail

The image of the connected camera or CF card will display.
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Loading Images from the Camera

1. Create a folder in which to save the images from the camera.
In the explorer view, right click the [My Images] folder. Select [Rename Folder] from
the pop-up menu and input a folder name.

2. Select the renamed folder.
Click the renamed folder in the explorer view.

3. Select the images that you wish to download from the camera window
and click the [DOWNLOAD] button.
Click the thumbnail(s) you wish to select.

Thumbnail

Explorer View
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The downloaded images will display in the browser area.

To disconnect the camera, click the close box  at the upper right of the camera
window. The camera window will close.

Browser Area
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Printing Images

1. Select the image(s) you wish to print and click the [PRINT] button.

The PhotoRecord printing utility will start and the selected image(s) will automatically
display in a page layout.

2. Adjust the print settings if you wish to change the page layout.
Please refer to page 27 or the PhotoRecord Help file for instructions.

3. Click the PhotoRecord [PRINT] button.

The Print dialog will display.

4. Click the [OK] button to start printing.
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Basic Procedures for Using ZoomBrowser EX

This section provides a simple explanation of the basic procedures for using ZoomBrowser
EX. Please refer to the ZoomBrowser EX Help file for more details.

Displaying Images
Zooming Images In and Out
(a) Double-Clicking the Browser Area

Double-click the background frame of a folder to zoom it to fill the browser area.

(b) Selecting a Folder in the Explorer View
You can also zoom a folder in or out with its icon selected in the explorer view.

Double-Click the
Background Frame of
the Folder

Browser Area

Click a higher level folder to zoom out.

Click a lower level folder to zoom in.

Click this button to
go back to a folder
one level higher.
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Zooming a Single Image
Double-click an image in the browser area.

Displaying Images in Chronological Order
Select a folder or some images, click the [View] menu and select [TimeTunnel].
• The selected image(s) will display in a time tunnel window.
• Please refer to the TimeTunnel Help file for more details on how to operate this

function.

Double-Click the Image

Drag the tab up or down to move
through the time tunnel.

To return to the browser window,
click this button.
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Organizing Images

Changing the Image Location
You can change the location of an image by dragging and dropping it.

The [Image Library One] folder is located within the folder in which ZoomBrowser EX
was installed. The explorer view displays files at levels below this folder.

Add a New Library Folder
• Adding a folder to the explorer view allows you to display the images in that folder

and its subfolders in ZoomBrowser EX.
• Click the [File] menu, select [Add Image Library] and select the folder. The selected

folder will appear in the explorer view as a new library.

Refresh the Contents of a Library
If you have used another program, such as Windows Explorer or Adobe PhotoDeluxe,
to move or edit images that are registered with ZoomBrowser EX, you should click the
[View] menu and select [Refresh Current Library].

Browser Area

Explorer View

Drag and drop
within the
browser area

Drag and drop from the browser area
to the explorer view
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Saving Computer Images to a CF Card in the Camera
1. Open the camera window. (➔ p. 15)

2. Click the [UPLOAD] button in the camera window.

3. Select the images from the computer and click the [Open] button.
The [Upload Images from Disk] dialog will display. Select the images you wish to
save to the camera and click the [Open] button. The [Save to Camera] dialog will
display.

4. Select image size and resizing options and click the [Save to Camera]
button.
The selected image will be saved onto the camera’s CF card.

Editing Camera Slide Shows
1. Open the camera window. (➔ p. 15)

2. Click the [EDIT SLIDESHOW] button.
The Edit Slide Show window will display.
• The camera images will display on the left side. Images registered in the selected

slide show will display on the right side.
• Slide Shows 1 to 3 correspond to the numbers of the slide shows that can be

shown with the camera.

3. Drag and drop images from the area on the left to the area on the right
to register them in the slide show.
You can drag images to change their order in the area on the right. This order
corresponds to the order in which they replay.

4. Click the [Save to Camera] button.
The slide show will be saved to the CF card in the camera.

5. Click the [Exit] button on the toolbar.
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Stitching Panoramas Together with PhotoStitch
To Merge Images Registered in ZoomBrowser EX
• You can merge a series of overlapping images into a single, seamless panorama.
• Select the images in the browser area, click the [Edit] menu and select [PhotoStitch].

The PhotoStitch program will start.
• Follow the instructions in the guidance window to merge the images.
• Please refer to the PhotoStitch Help file for more details.

Images Shot in Stitch Assist Mode
PhotoStitch automatically arranges images shot with the Stitch Assist mode of
PowerShot digital cameras into the correct order and orientation, making it easy
to merge these images. Stitch Assist mode images display in the camera window
as shown below.

Please see the camera’s User Guide for instructions for shooting in Stitch Assist mode.

Follow the instructions
to merge the images.

Images shot in Stitch Assist mode have a green stitch mark.
Click the stitch mark to start PhotoStitch and merge those images.
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Editing and Applying Special Effects to Images
1. Confirm that the Adobe PhotoDeluxe program has been installed.

(Install it from the Adobe PhotoDeluxe CD-ROM)

2. Select images from the browser area of ZoomBrowser EX.

3. Click the [Edit] menu and select [Edit Image using Adobe PhotoDeluxe
Home Edition]
Please refer to the Adobe PhotoDeluxe Help file and electronic guide (Getting
Started.pdf) for instructions for this program.

4. Edit and apply special effects to the image.
• Once you have finished editing the image, click the [File] menu and select [Export]

and [File format] and save the image.
• ZoomBrowser EX supports the BMP, FlashPix, JPEG and TIFF file formats.
• If you selected a folder registered in ZoomBrowser EX as the save location, please

return to the ZoomBrowser EX window, click the [View] menu and select [Refresh
Current Library] to update the thumbnail in ZoomBrowser EX.
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Printing Images
Select the folder or image(s) for printing from the browser area or camera window and click
the [PRINT] button to start the PhotoRecord program. The selected images will automati-
cally display in a page layout. Please refer to the PhotoRecord Help file for more details.

Use these buttons to arrange
the layout for each page.

Drag the images to change
the layout.

Slide this left to reduce the
image, right to enlarge it.

Click this to display Help

Click this to display the Print
dialog.

Click this to change the
background design or paper
orientation.

Click this to set the default
number of images printed per
page.

Click this to switch between
auto and manual layout
mode.

Click this to redo the layouts
for all pages.

Click this to stop importing
images.

Image Resizing Mode Image Rotating Mode

Drag an arrow to resize
the image.

The arrows
display when the
mouse is
positioned over
the image.

Click this to change
to rotating mode.

Click this to
display a pop-
up menu.

Drag an arrow to rotate
the image.

Click this to change
to image resizing
mode.

Click this to
display a pop-
up menu.
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Loading Images with TWAIN-Compliant
Application Programs

This section explains how to load images into TWAIN-compliant application programs.
Please read the manual for each application program for detailed instructions.
This example uses Adobe PhotoDeluxe to illustrate typical procedures.

Starting the Software
1. Connect the camera to the computer.

• Connecting to a USB Port (➔ p. 8)
• Connecting to a Serial Port (➔ p. 13)
• Connecting via a CF Card Reader or PC Card Slot (➔ p. 14)

2. Start Adobe PhotoDeluxe.

3. Turn the camera’s mode dial to the  position.
USB Interface

• The [PowerShot S10 Event] or [PowerShot S20 Event] dialog will display when you
connect the camera to a USB port so that you can select which application to start.

• Select Adobe PhotoDeluxe Home Edition and click the [OK] button. The TWAIN
Driver will appear.

Serial Interface / PC Card Reader or PC Card Slot Interface

1. Click [Get & Fix Photo] at the upper left of the window.
2. Click [Get Photo] from the dialog that displays and select [Cameras].
3. Click the [1 Camera] tab.

• Confirm that [Canon PowerShot RS-232C] is selected as the [Camera Models]
option.

4. Click the [Open Camera] button.
• TWAIN Driver will start.

Steps 5 and 6 are for Serial Interface Users Only

5. Click the [Communication Settings] button.
6. Set the port type, port name and baud rate settings, and click the [OK] button.

• Select [RS-232C] for the port type.
• For the port name, select the port to which the interface cable is connected. If you

are uncertain about the port to which it is connected, click the [Detect] button.
• There is usually no need to change the baud rate setting from 115.2 K, but if

you are having trouble with the connection, try a slower baud rate.
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Guide to the TWAIN Driver Window

Loading Images from the Camera
1. Click the [Camera] button.

• Click the [My Computer] button if you are loading images directly from a CF card.
• The images from the camera or CF card will display in the thumbnail display area.

2. Select an image and click the [Acquire] button.
The acquired image will appear in the window of Adobe PhotoDeluxe.

Settings Button Rotate 90 Degrees Buttons
Rotates the selected image left or right 90 degrees.

Display Style
Buttons

Thumbnail Display Area
Thumbnail (small) images display here
when the camera is connected.

Main Buttons
These buttons control the main commands for actions
such as loading images and exiting TWAIN Driver.

Help Button

This button does
not appear in the
USB version of
TWAIN Driver.
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Troubleshooting the Driver Software Installation

Confirm the Following Conditions:
1. Is the camera connected to the computer correctly? (p. 7)
2. Is the camera's mode dial in the  position?
3. Is the battery charge sufficient?

You are recommended to use the AC adapter when connecting to a computer.

You will not be able to confirm the driver status if there is a problem with one of the
items above.

If you answered no to one of the above questions, try reinstalling the
drivers with the procedures in the Installing the Driver Software section
when the [Add New Hardware Wizard] appears.

Check to See That Installation Conditions are Met

• Does the appropriate item, PowerShot S10 or PowerShot S20, appear in
the Scanners and Cameras Properties dialog?

Use the following procedures to display the dialog.
1. Click the Windows [Start] menu and select [Settings] and [Control Panel].
2. Double-click the [Scanners and Cameras] icon.

Confirm that the appropriate item, PowerShot S10 or
PowerShot S20, is displayed.
The names of scanners and other devices for which drivers
have already been installed will show in this window.
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What to Do if [PowerShot S10] or [PowerShot S20] Is Not in
the Scanners and Cameras Properties Device List or if the
[Scanners and Cameras] Icon Is Not in the Control Panel

1. Open the [System Properties] dialog and check the [Device Manager] tab.
1. Double-click the [System] icon in the Control Panel.
2. Click the [Device Manager] tab.

2. Check the [Other devices] or [Imaging Devices] categories for either the
[PowerShot S10] or [PowerShot S20] item. Delete it with the following
procedures.

1. Select either the [PowerShot S10] or [PowerShot S20] item and click the
[Remove] button.

2. Click the [OK] button on the confirmation dialog.
3. Click the [OK] button to close the System Properties dialog.

Delete all copies if the [PowerShot S10] or [PowerShot S20] item appears in more
than one category, such as the [Imaging Devices] and [Other Devices], or if it is
duplicated in the [Other Devices].

3. Double-click the [My Computer] icon on the Windows desktop.

4. Double-click the [C:] hard disk drive icon to open it.
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5. Double-click the [Windows] folder to open it.

6. Double-click the [Inf] folder to open it.
If you do not spot the [Inf] folder in the Windows folder, click the [View] menu and select
[Folder Options], the [View] tab and the [Show All Files] option. (➔ p. 33)

7. Find and delete the [Drvdata.bin] and [Drvidx.bin] files.

8. Double-click the [Other] folder within the [Inf] folder to open it.

9. Find and delete the [Canon.IncCanon_DC] file.
Skip this step if this file is not present in the [Other] folder within the [Inf] folder.

Reconnect the camera to the computer and reset its mode dial to the 
position.
The [Add New Hardware Wizard] will appear.

Install the driver software according to the procedures in the Installing the
Driver Software section starting on page 10.

The [Inf] folder contains numerous files. Ensure that you double-
check the file names before you delete any files.

10.

11.
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What to Do if the [Inf] Folder Does Not Appear in the
[Windows] Folder

Follow the procedures below to select the [Show all files] option.
1) Click the [View] menu and select [Folder Options].
2) Click the [View] tab.
3) Click the [Show all files] option in the Hidden files section of the Advanced

settings list.
4) Click the [OK] button to close the [Folder Options] dialog.

This will display the folders and files that were not previously visible.
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What to Do if [PowerShot S10] or [PowerShot S20] Appears in
the Scanners and Cameras Properties Device List

1. Select the [PowerShot S10] or [PowerShot S20] name in the Scanners and
Cameras Properties device list and click the [Remove] button.

2. Click the [OK] button and close the [Scanners and Cameras Properties] dialog.

3. Using Steps 3 to 11 on starting on page 31, delete the [Drvdata.bin],
[Drvidx.bin] and [Canon.IncCanon_DC] items, and reinstall the driver
software.
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Introducing the Software

This section introduces the powerful software programs provided on the supplied CD-ROM
for Macintosh computers.

PowerShot Solution Disk

PowerShot Browser

To load PowerShot S10/S20 images, start PowerShot Browser.

PowerShot S10/S20 Connection Functions
  (Also effective for CF card readers or PC card readers)
• Displays the camera images.
• Downloads camera images to the computer.
• Saves computer images to a CF card in the camera.
• Edits slide shows for replay by the camera.
• Automatically starts and displays camera images when the camera is connected to a

USB port.

Image File Management Functions
• Displays, moves, copies or deletes images stored on computer disks.
• Displays the files in a specified folder.
• Displays files in chronological order in a window that looks like a time tunnel.

Prints Images
• Prints a specified number of images on a single page.

Supports PhotoStitch Panoramas
• Allows you to select camera images or images registered with PowerShot Browser and

start PhotoStitch to merge a series of images into a panorama in a few simple steps.

Supports the Adobe PhotoDeluxe Photo Retouching Program
• Starts the Adobe PhotoDeluxe photo retouching program so you can edit and apply

special effects to your images.
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PhotoStitch
• Automatically arranges images shot in Stitch Assist mode into the correct order and

effortlessly merges them.
• Merges any number of images horizontally or vertically, or in a matrix format.
• Makes images with straight lines appear natural not crooked when merged (Select the

Wide display format).
• A 360 degrees scene shot in several frames can be merged into a 360 degrees image

and saved in the QuickTime VR format, making it appear as if you were standing in the
middle of the image looking about in all directions.

PowerShot Plug-In Module

This is the driver utility required to load images from a camera into a Plug-In
compliant application program, such as Adobe PhotoDeluxe or Photoshop.
Plug-In Module cannot be used as a stand-alone software program.

 Adobe PhotoDeluxe (separate CD-ROM)

• Allows you to edit images and effortlessly create greeting cards, birthday cards and
calendars.
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System Requirements

The following system requirements must be met to install and operate the software.

• A CD-ROM drive is required to install the software.
• Plug-In Module 3.0 is compatible with Adobe Photoshop Ver. 3.0 or higher.
• QuickTime 2.5 or higher and the QuickTime VR Extension 2.0.1 or higher are required

to save images in the QuickTime VR format that have been merged in PhotoStitch.

•Computer Model
Power Macintosh, PowerBook, iMac or iBook

•OS
Mac OS 7.5.3 or higher, QuickTime 2.1 or higher

•CPU
PowerPC

•RAM
20 MB or more of application memory

• Interface
USB

Power Macintosh NEW G3/G4, PowerBook G3,
iMac, iBook
• Limited to genuine Apple Computer brand

models with a built-in USB interface
• iMacs running System Software 8.1 require

installation of “iMac Update 1.0“and “iMac
Firmware Update 1.0“

RS-422
Printer or modem port

•Free Hard Disk Space
PowerShot Utilities

PowerShot Browser: 20 MB or more
PhotoStitch: 30 MB or more

PowerShot Plug-In Module: 15 MB or more
Adobe PhotoDeluxe: 70 MB or more

•Display
800 x 600 pixels, 256 colors minimum
1,024 x 768 pixels, Thousands of colors or more

recommended
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Installing the Software

Installing from the PowerShot Solution Disk

1. Close any application programs that are running.

2. Place the supplied Solution Disk in the CD-ROM drive.

3. Double-click the [CD-ROM] icon.

4. Double-click the
[PowerShot Installer]
icon.
The installer panel will
display.

5. Click [Software Installation] and Select the software programs you wish
to install.
• Select [Easy Install] for a typical installation.
• Select [Custom Install] if you wish to install only the minimum required programs.

Software Installed with the Easy Install Option
PowerShot Browser, PhotoStitch, PowerShot Plug-In Module

6. Select a folder and proceed according to the on-screen instructions.

7. Restart the computer after the installation is complete if prompted by a
message.

Installing Adobe PhotoDeluxe
For installation instructions, please see the electronic guide (Getting Started.pdf)
contained in the [Open Me First!] folder on the Adobe PhotoDeluxe CD-ROM.

The serial number shown during installation will be required for the user
registration process.
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Connecting the Camera to a Computer

There are three interfaces that can be used to connect the camera to a computer. Once a
connection is established using one of the three interfaces, you can start the software
and begin to load the camera images. (➔ p. 45 or 55)

Connecting to a USB Port (➔ p. 41)
If your computer is equipped with a USB port such as that shown below, you can
connect the camera to it with the supplied USB cable.
• The USB interface transfers data more rapidly than the serial interface and can start

the image loading software automatically.

Connecting to a Serial Port (Printer or Modem Port) (➔ p. 43)
If your computer is equipped with one of the serial ports shown below, you can
connect the camera with the supplied Macintosh cable.

Connecting via a CF Card Reader or PC Card Slot  (➔ p. 44)
If your computer is equipped with a CF card reader or PC card slot, you can place the
camera’s CF card into either device to establish a direct connection.

Computer’s USB Port

Computer’s Serial Ports
(Printer or Modem Port)

Connectors on Ends of USB Cable

To the Camera To the Computer

USB Ports are
identified with
this mark.

Connectors on Ends of Serial Cable

To the Camera To the Computer

Serial Ports are
identified with
this mark.
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Connecting to a USB Port

Requirements for the USB Interface
• Use of the USB interface for connecting the camera is limited to the Power

Macintosh New G3/G4, PowerBook G3, iMac and iBook series with built-in USB
connectors.

• Connect the USB cable directly to one of the computer’s main USB ports. The
interface may not function correctly if the camera is connected via a USB HUB.

• The interface may not function correctly while other USB devices, excluding USB
mice and keyboards, are connected. If this problem arises, detach the camera
and the other devices, and reconnect the camera only.

Important
Please do not place your Macintosh computer into sleep mode while this
camera is connected to its USB port. If the computer is placed into sleep
mode while the camera is connected to the USB port, do NOT disconnect the
USB cable from the camera or computer. Try to revive the computer. If the
USB cable is detached while the computer is in sleep mode, some Macintosh
models may not return to active mode correctly. For instructions regarding
the sleep mode, please consult the manual accompanying your computer.
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1. Attach the supplied USB cable to a USB port directly on the computer
and to the DIGITAL terminal on the PowerShot S10/S20 as shown below.
• There is no need to turn the camera or computer power off when attaching or

detaching the USB cables.
• Please consult your computer’s manual for the location of the USB ports.
• The camera can be connected to any USB port on computers that feature more

than one.

Precaution for Unplugging Cables from the
DIGITAL Terminal

DIGITAL Terminal
1. Open the DIGITAL terminal

cover by slipping a
fingernail under the top
edge and pulling down.

2. Insert the cable so that the  marks on
the cable and camera align.

Always press the [PUSH] button on the connector to
detach the cable from the camera’s DIGITAL terminal.

PUSH Button

USB Port

USB Cable

USB Cable



43

M
a
ci

n
to

sh

Always press the [PUSH] button on the connector to
detach the cable from the camera’s DIGITAL terminal.

PUSH Button

Precaution for Unplugging Cables from the
DIGITAL Terminal

Connecting to a Serial Port (Printer or Modem Port)

1. Shut down the computer and turn the camera’s mode dial to the Off position.

2. Attach the supplied Macintosh cable to the printer or modem port on the
computer and to the camera’s DIGITAL terminal as shown below.
• Please consult your computer’s manual for the port locations.

3. Turn on the computer.

Macintosh Cable

Printer Port         Modem Port

Macintosh
Cable

DIGITAL Terminal
1. Open the DIGITAL terminal

cover by slipping a
fingernail under the top
edge and pulling down.

2. Insert the cable so that the  marks
on the cable and camera align.
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Connecting via a CF Card Reader or PC Card Slot

To load images directly from a CF card to a computer, eject the card from the camera,
place it in a separately sold PC card adapter (PCMCIA card adapter) and insert the
assembly into the PC card slot as shown below.
The adapter is not required if your computer is equipped with a CF card reader. Place the
CF card directly into the reader.

1. Place the CF card in the PC card adapter.

2. Insert the assembly into the computer’s PC card slot or a PC card reader
attached to the computer.
The requirements for the power being on or off when the PC card adapter is
inserted differ according to the product. Please consult the manuals accompanying
your equipment.

Place CF Card in Adapter

Insert into Slot
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From Loading to Printing

This section provides a simple explanation of the procedures for using PowerShot Browser
to load and print images. Please refer to the PowerShot Browser Help file for more details.

Canon PowerShot Icon

Auto Save and Batteries
When the camera is connected to a computer and powered by a 2CR5 lithium
battery or Battery Pack NB-5H, a message will ask if you wish to remain connected
after approximately five minutes without a camera control being accessed. If you
select [No], the camera will shut down after approximately one minute (PC icon
disappears from the display panel). You can restore the connection by pressing
the shutter button (PC icon displays in the display panel).

Starting PowerShot Browser

1. Open a connection between the camera and computer.
• Connecting to a USB Port (➔ p. 41)
• Connecting to a Serial Port (➔ p. 43)
• Connecting via a CF Card Reader or PC Card Slot (➔ p. 44)

2. Turn the camera’s mode dial to the  position.
For Serial Interface Users
• If you are connected to an AppleTalk network via the printer or modem port,

choose the  (Apple) menu, select [Chooser] and set AppleTalk to [Inactive].

3. Start PowerShot Browser.
• Double-click the [Canon PowerShot] icon on the desktop.
• If the Canon PowerShot icon does not appear on the desktop, look in the folder

in which you installed the programs and double-click [PowerShot Folder],
[PowerShot Browser Folder] and the [PowerShot Browser] icon.
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Serial Interface

Click the [CAMERA] button. Thumbnail images will display in the camera window.
(➔ p. 51)

Having Trouble Connecting to the Computer?
If the settings for the connection port are not
correct, the [Communication Settings] dialog
will display. (It will not display if you are
connecting via a USB port.)

• Set the connection port and baud rate settings and click the [Set] button.
• Select the port to which the camera is attached.
• There is usually no need to change the baud rate setting from 115.2 K,

but if you are having trouble with the connection, try a slower baud rate.

4. Use one of the three interfaces to display the camera window.
USB Interface
When you connect the camera to the computer, PowerShot Browser will automatically
start and display its [Communication Settings] dialog. Confirm that the [USB port]
option and either the [PowerShot S10] or [PowerShot S20] option are selected. Click the
[Set] button. Thumbnail images will display in the camera window.  (➔ p. 47)
• If you don’t want PowerShot Browser to start automatically, change the settings

with the following procedures.
1. Choose Control Panels from the  (Apple) menu

and select [Canon USB Camera]. The [Settings for
USB connection] dialog will display.

2. Click the [The application program below will
start.] option to clear the check mark.

3. Click the close box at the upper left to close the
dialog. PowerShot Browser will cease to start
automatically thereafter.

Clear the check mark to stop PowerShot
Browser from automatically starting.
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PowerShot Browser Camera Window
The camera window will open when a connection to a camera or CF card is initiated.
Thumbnail (small) images will display.

Thumbnail

The image of the connected camera or CF card will display.

PC Card Reader or PC Card Slot Interface

Click the arrow to the left of PC Card folder in the explorer view to display the
subfolders and double-click [DCIM].
Thumbnail images will display in the Camera window. (➔ p. 47)

Explorer View
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Loading Images from the Camera
1. Select the [PowerShot Browser Folder].

Click the arrow to the left of the folder in the explorer view and display the
contents of the [PowerShot Browser Folder].

2. Create a new folder within the PowerShot Browser Folder.
Click the [PowerShot Browser Folder], choose the [File] menu and select [New
Folder]. A folder with the name [Untitled Folder] will be created. Click the folder
and change the name of this folder as you wish.

3. Select the folder you just created.
Click the newly created folder in the explorer view.

Click the arrow to show the
folder’s contents.

Explorer View
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Printing Images
1. Select the image(s) you wish to print and click the [PRINT] button.

2. Input a title into the header space, select the number of images you wish
to print on one page and click the [PRINT] button.

4. Select the images that you wish to download from the camera window
and click the [DOWNLOAD] button.
Click the thumbnail(s) you wish to select.

The downloaded images will display in the browser area.

To disconnect the camera, click the close box  at the upper left of the camera
window. The camera window will close.

Thumbnail

Browser Area
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Basic Procedures for Using PowerShot Browser

This section provides a simple explanation of the basic procedures for using PowerShot
Browser. Please refer to the PowerShot Browser Help file for more details.

Displaying Images
Zooming Images In and Out
You can zoom images in and out by clicking the  (REDUCE) or  (ENLARGE) button.

Zooming a Single Image
Double-click an image in the browser area.

Displaying Images in Chronological Order
Select a folder, choose the [Browser] menu and select [Switch to TimeTunnel].
• The selected image(s) will display in a time tunnel window.
• Please refer to the TimeTunnel Help file for more details on how to operate this function.

To return to the browser window, choose the [TimeTunnel] menu and select [Switch to
Browser View].

Drag the tab up or down
to move through the
time tunnel.
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Organizing Images

Changing the Image Location
(a) Dragging an Image from the Browser Area and Dropping It to the

Explorer View.

(b) Drag and Drop a Folder within the Explorer View.

Refresh the Contents of the Browser Area
If you have used the Macintosh Finder or another program to move or edit images that
are registered with PowerShot Browser, you should click the [Display] menu and select
[Refresh].

The image will move to
the folder displaying
the black underline.

Explorer View

Browser Area
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Saving Computer Images to a CF Card in the Camera
1. Open the camera window. (➔ p. 46)

2. Click the [UPLOAD] button in the camera window.

3. Select the images from the computer and click the [Open] button.
Select the images you wish to save to the camera in the dialog that appears and
click the [Open] button.
The [Save to Camera] dialog will display.

4. Select image size and resizing options and click the [Save to Camera]
button.
The selected image will be saved onto the camera’s CF card.

Editing Camera Slide Shows
1. Open the camera window. (➔ p. 46)

2. Click the [EDIT SLIDESHOW] button.
The SlideShowMaker window will display.
• The camera images will display on the left side. Images registered in the selected

slide show will display on the right side.
• Slide Shows 1 to 3 correspond to the numbers of the slide shows that can be

shown with the camera.

3. Drag and drop images from the area on the left to the area on the right
to register them in the slide show.
You can drag images to change their order in the area on the right. This order
corresponds to the order in which they replay.

4. Click the [Save to Camera] button.
The slide show will be saved to the CF card in the camera.

5. Click the [Quit] button on the toolbar.
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Stitching Panoramas Together with PhotoStitch
To Merge Images Registered in PowerShot Browser
• You can merge a series of overlapping images into a single, seamless panorama.
• Select the images in the browser area, choose the [Edit] menu and select

[PhotoStitch]. The PhotoStitch program will start.
• Follow the instructions in the guidance window to merge the images.
• Please refer to the PhotoStitch Help file for more details.

Images Shot in Stitch Assist Mode
PhotoStitch automatically arranges images shot with the Stitch Assist mode of
PowerShot digital cameras into the correct order and orientation, making it easy
to merge these images. Stitch Assist mode images display in the camera window
as shown below.

Please see the camera’s User Guide for instructions for shooting in Stitch Assist mode.

Follow the instructions to
merge the images.

Images shot in Stitch Assist mode have a green stitch mark.
Click the stitch mark to start PhotoStitch and merge those images.
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Editing and Applying Special Effects to Images
1. Confirm that the Adobe PhotoDeluxe program has been installed.

(Install it from the Adobe PhotoDeluxe CD-ROM)

2. Select images from the browser area of PowerShot Browser.

3. Click the [Edit] menu and select [Adobe PhotoDeluxe].
Please refer to the Adobe PhotoDeluxe Help file and electronic guide (Getting
Started.pdf) contained in the [Open Me First!] folder on the Adobe PhotoDeluxe
CD-ROM.

4. Edit and apply special effects to the image.
• Once you have finished editing the image, click the [File] menu and select [Send

to] and [File Format] and save the image.
• PowerShot Browser supports the BMP, JPEG, PICT and TIFF file formats.
• Click the [Display] menu and select [Refresh] to update the folder data.

Adding Sound Files to Images
If your computer has a microphone, you can attach a sound annotation to an image by
clicking it in the browser area, choosing the [Sound] menu and selecting [Record].
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Loading Images with Plug-In Compliant
Application Programs

This section explains how to load images with Plug-In compliant application programs.
Please read the manual for each application program for detailed instructions.
This example uses Adobe PhotoDeluxe to illustrate typical procedures.

Installing the Plug-In Module
1. Open the [PowerShot Folder] and [Plug-In Folder].

2. Copy the [Canon PowerShot] file to the [Acquire/Export] folder, which can be
found by opening the [Adobe PhotoDeluxe] and [Plug-ins] folders.

Starting the Software
If PowerShot Browser has been installed, it will start automatically when the camera is
connected to the computer via a USB port. To stop PowerShot Browser from starting
automatically, turn off the automatic start function using the procedures described in
the USB Interface topic on page 46.

1. Connect the camera to the conputer.
• Connecting to a USB Port (➔ p. 41)
• Connecting to a Serial Port (➔ p. 43)
• Connecting via a CF Card Reader or PC Card Slot (➔ p. 44)

2. Turn the camera’s mode dial to the  position.
For USB Interface Users
• PowerShot Browser may automatically start when you connect the camera to the

computer. Since you will be using the plug-in compliant application to load
images, you should close PowerShot Browser.

• To prevent PowerShot Browser from automatically starting, see the procedures on
page 46.

For Serial Interface users
• If you are connected to an AppleTalk network via the printer or modem port,

choose the  (Apple) menu, select [Chooser] and set AppleTalk to [Inactive].

3. Start Adobe PhotoDeluxe.
1. Click the [Get Photo] button at the upper left of the window.
2. Click [Get Photo] from the tab that displays and select [Cameras].
3. In the [Select Input Source] dialog, select [Canon PowerShot] and click the [OK] button.

• This step is not required from the second time onward.
4. Click the [Camera] icon.

• The Plug-In Module will start.
5. Click the  icon and set the communication settings.

USB Interface
Confirm that the [USB Port] and either [PowerShot S10] or [PowerShot S20]
have been selected and click the [Set] button.
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Serial Interface
Select the port and baud rate settings, and click the [Set] button.
• Select the port to which the camera is attached.
• There is usually no need to change the baud rate setting from 115.2 K, but

if you are having trouble with the connection, try a slower baud rate.

What to Do if the [PowerShot Browser not found] Dialog Appears
If you install only the PowerShot Plug-
In Module without PowerShot
Browser, the [PowerShot Browser not
found] dialog may display. If this
happens, use the following procedures to prevent PowerShot Browser from
attempting to start automatically.
1) Click the [OK] button on the [PowerShot Browser not found] dialog.
2) In the [Settings for USB connection] dialog, click the [The application program

below will start.] option to clear the check mark.
3) Close the [Settings for USB connection] dialog.

This will prevent the [PowerShot Browser not found] dialog from appearing again
when the camera is connected.
* The [Settings for USB connection] dialog can also be opened by choosing the 

(Apple) menu and selecting [Control Panels] and [Canon USB Camera]. (➔ p. 46)

Click here to close the dialog.

Click here to clear the check mark.
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Guide to the Plug-In Module Window

Loading Images from the Camera
1. Click the [Camera] button.

• Click the [Computer] button if you are loading images directly from a CF card.
• The images from the camera or CF card will display in the thumbnail display area.

2. Select an image and click the [Acquire] button.

3. In the [Untitled] column of PhotoDeluxe, input a file name and click the
[Save] button.
The thumbnails will appear in the My Photos window at the lower right of the
Adobe PhotoDeluxe window.

4. Click the [Quit] button.
You can display an image at a larger size by double-clicking it in the My Photos
window.

Display Style Button

Settings Buttons
Use these buttons to set
the communications and
preference settings for the
camera.

Thumbnail Display Area
Thumbnail (small) images display here when
the camera is connected.

Rotate 90 Degrees Buttons
Rotates selected image left or right 90 degrees.

Image Information Button

Main Buttons
These buttons control the main commands for actions
such as loading images and quitting Plug-In Module.
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Troubleshooting the Computer Connection

Double-Check:
1. Is the cable between the camera and computer correctly attached?

(➔ p. 7 or p. 40)
2. Is the camera’s mode dial turned to the  position? (➔ p. 10 or p. 45)
3. Is the battery charge sufficient?

You are recommended to use the AC adapter when connecting to a computer.

If the above conditions are met, check the following items.

• Confirm that the port selected in the Communication Settings dialog is
the one to which the camera is connected. Please see the respective
pages below.
Windows Platform (➔ p. 16)
Macintosh Platform (➔ p. 46)

• If there is more than one port, try connecting via another (different)
port.

• Set the baud rate to a lower setting in the [Communication Settings]
dialog.

• If you are using LocalTalk, set AppleTalk to [Inactive].
(➔ p. 45 Step 2, p. 55 Step 2)

If the problem persists after implementing the suggestions above, please contact a Canon
Customer Support Help Desk.
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Customer Support

Canon Customer Support
Canon Inc.

30-2 Shimomaruko 3-chome, Ohta-ku, Tokyo
146-8501, Japan

NORTH AMERICA
Canon U.S.A., Inc.
Canon Customer Care Center
Phone (US): 1-800-828-4040 (Available Mon. - Fri., 9 AM to 8 PM Eastern Time)

Canon Canada Inc.
Phone (Canada): 1-800-OK-CANON (1-800-652-2666) (24 hours/day, 7 days/week)

EUROPE
Europe, Africa & Middle East

Canon Europa N.V.
PO Box 2262, 1180 EG Amstelveen, The Netherlands

Canon (UK) Ltd.
Helpdesk
Tel No.: 08705 143 723 (Calls may be recorded.)
Fax No.: 08705 143 340     BBS No.: 08705 143 350

Canon France S.A.
Hotline : 01.41.99.70.70
Tél : 01.41.99.77.77     Télécopie : 01.41.99.79.51

Canon Photo Vidéo France S.A.
Hotline : 01.49.04.01.00     Télécopie : 01.49.04.01.01

Canon Deutschland GmbH
Canon-Hotline-Service
Customer-Support: (02151) 349-555     Telefax: (02151) 349-588
Info-Desk Tel: (02151) 349-566     Info-Desk Fax : (02151) 349-599     Mailbox : (02151) 349-577

Canon Euro-Photo GmbH
Customer-Support: (02154) 495-610
Info-Desk: (02154) 495-444
Fax: (02154) 495-333

Canon Italia S.p.A.
Pronto Canon : 02 8249 2000     BBS : 02 8249 2099

Canon Belgium N.V. / S.A.
Helpdesk: 0900-10627
Tel.: (02) 722.04.11     Fax: (02) 721.32.74

Canon Luxembourg S.A.
Tel.: (352) 48 47 961     Fax: (352) 48 47 96232

Canon Nederland N.V.
Helpdesk: 023 - 5 681 681
Tel.: 023 - 5 670 123     Fax: 023 - 5 670 124

Canon Danmark A/S
Hotline: 44 88 26 66

Canon España S.A.
Help Desk: 906 301 255
Tel: (91) 538 45 00     Fax: (91) 411 41 76
E-mail: helpdesk@btlink.net
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Canon Norge as
Tlf. 22 62 93 21     Faks: 22 62 06 15
E-mail: helpdesk@canon.no

Finland

Canon OY
Puhelin: 010 54420     Fax: 010 544 4571
Help Desk: 0600 0 22606 (14,80 mk/min+pvm)
Help Desk: 0600 0 22666 (enint. 40mk/puhelu+pvm)
Sähköposti: helpdesk@canon.fi

Canon (Schweiz) AG
Tel. 01-835-6161,  Fax 01-835-6860
Hotline 0900 57 55 20

Canon Svenska AB
Stensätravägen 13, S-127 88, Skärholmen, Sweden

Austria

Canon GmbH
Zetschegasse 11, 1232 Wien, Austria
Tel: 01 680 88-0
Fax: 01 680 88-222

OCEANIA
Canon Australia Pty. Ltd.
Info-Line: (02) 9805 2864

Canon New Zealand Ltd.
Info-Line: 0900-522666

ASIA
Canon Singapore Pte. Ltd.
79 Anson Road, #09-01 / 06, Singapore 079906
Phone: (65) 532 4400     Fax: (65) 221 7577

Canon Hongkong Co., Ltd.
9/F, The Hong Kong Club Building, 3A Chater Road, Central, Hong Kong
Phone: 852-2739-0802     Fax: 852-2369-7701

Canon Marketing Services
No.1 Jalan Kilang Timor, #09-00, Pacific Tech Centre,
Singapore 159303
Phone: (65) 799 8888     Fax: (65) 273 3317

Canon Marketing (Malaysia) Sdn. Bhd.
Wisma General Lumber, Block D, Peremba Square,
Saujana Resort, Section U2, 40150,
Shah Alam, Selangor Darul Ehsan, Malaysia
Phone: (60) 3 744 6000, (60) 3 745 0055
Fax: (60) 3 745 0505

Canon Marketing (Thailand) Co., Ltd.
10th Floor, Bangkok City Tower,
179/34-45 South Sathorn Road,
Bangkok 10120, Thailand
Phone: (662) 344 9999      Fax: (662) 344 9910

Canon Marketing (Hongkong) Co., Ltd.
10/F, Mirror Tower, 61 Mody Road, Tsimshatsui East
Kowloon HongKong
Phone: 852-2170-2828      Fax: 852-2723-9684



61

Adobe Customer Support
To view information on the support options available from Adobe:

Windows

1. Use the Microsoft windows Explorer to open the [Support] folder in the
PhotoDeluxe Home Edition CD-ROM.

2. Double-click the folder that corresponds to your geographic location.
Inside, you will find a file that contains more detailed support informa-
tion for your location.

Macintosh computer

1. Open the [Support] folder in the PhotoDeluxe CD-ROM.
2. Double-click the folder that corresponds to your geographic location.

Inside, you will find a file that contains more detailed support informa-
tion for your location.
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